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1.0 PURPOSE  

The purpose of this document is to provide guidelines and instructions for accessing and 
using the Electronic Technical Qualifications Program (eTQP) tool. 

2.0 APPLICABILITY 

This document is for Department of Energy (DOE) Federal and contractor employees 
who have been granted access to the eTQP tool. 

3.0 eTQP TOOL ACCESS 

The eTQP tool can be accessed at https://etqp.ntc.doe.gov/. Users must have an active 
eAccess account. 

For assistance with eAccess, go to https://eaccess.ntc.doe.gov/. 

4.0 REQUESTING HELP 

To obtain help with the eTQP tool, contact the NTC at 505-845-2001 (option 3) or 
etqpsupport@ntc.doe.gov. 

5.0 eTQP OPERATIONS 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP.  
Remember that exams may be classified, so check before uploading 
exams as supporting documents. 

5.1 Overview of eTQP Roles and Responsibilities 

The eTQP tool implements the roles and responsibilities of the Technical Qualification 
Program (TQP) as described in DOE O 426.1 Chg 1, Federal Technical Capability. The 
role assigned to an individual in eTQP determines his or her permissions and 
responsibilities within the tool, as shown in the table in Section 5.2. 

NOTE: Roles within the eTQP tool are associated with specific functions and 
responsibilities. The job titles at each site associated with these functions and 
responsibilities may not be the same as the eTQP role names. eTQP roles 
should be assigned to individuals based on their responsibilities, not their job 
titles. 

https://etqp.ntc.doe.gov/
https://eaccess.ntc.doe.gov/
mailto:etqpsupport@ntc.doe.gov
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5.2 eTQP Roles and Responsibilities 

eTQP Roles and Responsibilities 

Role Responsibilities 

eTQP Manager  Maintains the site eTQP database, including the following: 

o Helps develop and revise site-specific qual 
standards and qual cards 

o Enters Participants in the eTQP database after 
assignment to the program by Supervisor  

o Enters Participants in the database who have been 
transferred to the site 

 Sets up the site’s Qualifying Official (QO)-to-competency 
matrix 

 Enters approved site-level QOs and associated 
competencies into the eTQP database 

 Enters appropriate Program Office-level QOs into the eTQP 
database 

 Provides qual status updates and reports as requested 

 Initiates and assigns new qualification and requalification 
activities 

 Helps Participants during qualification and requalification 
activities 

 Changes assigned QOs if appropriate 

 Coordinates Participant’s final qualifying activities 

 Inactivates and reactivates Participant qual cards 

 Deletes qual cards assigned in error 

 Removes Participants transferred to different sites 

Participant   Completes qualification and requalification activities as 
assigned 

 Uploads evidence and documentation to eTQP to support 
qualification  

 Submits due date extension requests for assigned quals 

 Documents and provides evidence of competency 
satisfaction as required by site procedures; requests 
evaluation by QO 
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eTQP Roles and Responsibilities 

Role Responsibilities 

 Documents and provides justification and objective 
evidence of competency equivalencies; requests 
competency equivalencies from the approving authority 

 Coordinates final qualifying activities with eTQP Manager 

Supervisor/  
First Line 

Supervisor 

 Reviews and approves due date extension requests for 
assigned quals 

 Monitors and adjusts Participant requests for evaluation by 
specific QOs (if required) 

 Reviews and approves final qualifying activities 

 Suspends, deactivates, and reactivates qual cards when 
appropriate 

Second Line 
Supervisor  

(if applicable) 

 Reviews and approves or disapproves final qualifying 
activities 

Equivalency 
Reviewer 

 Evaluates and approves or disapproves equivalency 
requests from Participants 

Qualifying Official 
(QO) 

 Reviews and approves or disapproves competency review 
requests for assigned competencies 

 Selects competency evaluation method  

 Conducts and documents competency evaluations 

 Uploads evaluation evidence into eTQP as appropriate 

 May be assigned at the site level to evaluate competencies 
for site-specific quals (local QOs) 

 May be assigned at the Program Office level to evaluate  
competencies for general GTB- and FAQS-based quals  

FTCP Agent  Reviews and approves or disapproves final qualifying 
activities for Senior Technical Safety Manager (STSM) 
quals 
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5.3 Flowcharts 

5.3.1 eTQP Site Implementation 
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5.3.2 Qual Assignment and Acceptance  
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5.3.3 Qualification Process  
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6.0 eTQP BASICS  

  
eTQP BASICS 

• This section describes basic eTQP operations that 
are used in many different contexts, such as 
scrolling and sorting lists, locating items in lists, 
and managing uploaded documentation. 

• Look for the eTQP BASICS alert throughout this 
user guide. 

   

NOTE: On all eTQP screens, a red asterisk (*) indicates a required entry.  
 
Always click Submit before leaving a form to save your changes. 

6.1 Locate an Item in a List 

Many operations in eTQP require the selection of one or more items in a multiple-page 
list of users, qual cards, or competencies. Each type of list has different columns and 
column headings, but the process of locating and selecting a specific item is the same in 
all the lists. 

Locate an item by scrolling through a list (Section 6.1.1), sorting a list (Section 6.1.2), or 
filtering the items in a list (Section 6.1.3). 

NOTE: The Select User list contains entries for everyone with an active eAccess 
account, not just those active in TQP at a specific site. Be sure to select the 
correct name or names for each role, as there may be several individuals in the 
system with the same name. 
 
The easiest way to find a name in the list of active accounts is to filter the list by 
a few consecutive letters from the person's email address.   

6.1.1 Scroll through a List 

• Most lists in eTQP include a page navigation bar at the bottom of each page. Use the 
page navigation bar to move to different locations in the list. 

• Click the right arrow to move to the next page, or click the left arrow to move to the 
previous page. 

• Click the beginning or end arrow to move to the beginning or end of the list. 

• Click a page number to jump to another location in the list. 
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• Select 10, 20, or 50 from the Page size list to specify the number of records to show 
on each page. 

 

6.1.2 Sort a List or Grid 

Any list or grid in eTQP can be sorted in ascending or descending order by the values in 
one or more columns.  

NOTE:  After sorting, use the page navigation bar to scroll through the list. 

• To sort in ascending order by the values a specific column, click the column heading 
once.  

− The heading of the sorted column changes color. 

− The sort indicator arrow points up. 
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• To sort in descending order by the values in a specific column, click the column 
heading twice. 

− The sort indicator arrow points down. 

 

6.1.3 Filter a List 

Most lists in eTQP include the option to filter the list. If a text box and Filter icon appear 
beneath the column headings on a list page, follow these instructions to display a subset 
of the items in the list.  

NOTE: These instructions are written for the Select User lists, but they apply to all 
other lists that include the filter option. 

1. To filter the list by letters in an email address or name, type the letters in the text field 
below the column heading (First Name, Last Name, or Email).  

• Choose a few consecutive letters from anywhere in the email address or name, 
not just at the beginning. 

• For best results, choose letters that are likely to be found in a limited number of 
email addresses or names. 

2. Click the Filter icon and select CONTAINS from the list of filters. 

 

3. Select the correct individual in the filtered list of names. 
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• If the filtered list contains multiple entries for the same person, select the entry 
with the valid or current email address. 

For example, to locate a user named Sandra Fernandez, enter the letters “fern” or 
“nandez” in either the Email or Last Name filter field, and then click the Filter icon and 
select CONTAINS. 

 

 

Alternatively, enter the letters “san” or “sandra” in the First Name filter field, and then 
click the Filter icon.  
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6.1.3.1 Clear a List Filter 

To clear a filter and display the complete unfiltered list, follow these steps:  

1. Click inside the filter text field.  

2. Click the ‘x’ at the right side of the text field. 

3. Click the Filter icon. 
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6.2 Manage Documentation 

On any eTQP screen with a Supporting Documentation section, any user can upload, 
review, and remove relevant documents. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP.  
Remember that exams may be classified, so check before uploading 
exams as supporting documents. 

6.2.1 Upload Documents 

1. In the Supporting Documentation section, click Add Files to open the Choose File 
to Upload dialog box. 

 

2. On your local computer or network, navigate to the file to be uploaded. 

3. Select the file, and then click Open to return to the original eTQP screen. 

• The uploaded file appears in the Supporting Documentation list. 

 

6.2.2 Review Uploaded Documents 

1. In the Supporting Documentation section, click the View Document icon next to 
the relevant document. 
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2. In the confirmation dialog box, click Open or Save. 

 

• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 

6.2.3 Remove Uploaded Documents 

• In the Supporting Documentation section, click the Remove Document icon next 
to the relevant document. 

 

NOTE: Removing a document from the Supporting Documentation list is final 
and cannot be undone. 
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6.3  eTQP Icons 

eTQP Icons 

Action Icon 
Assign Qual Card 
Qual Directions tab 

 

 

Calendar 
 

Clone 
 

Delete 
Edit Site form   

Delete Participant 
Edit Site form > (any role tab)  

Delete Qual Card (Not Started) 
Qual Card Admin tab  

Disable 
 

Edit 
(Various tabs and forms)  

Edit Submission 
Admin Qual tab  

Enable 
 

Expand 
 

 or  

Expire 
Quals tab  

Export to Excel 
 

Filter 
 

Inactivate Qual Card 
Qual Card Admin tab  
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eTQP Icons 

Action Icon 

Initiate Qual Direction  

 

 

Load Legacy Qual Cards  
Edit Site Actions form > Participants tab 

 

 

Manage Competencies 
 

Page Navigation Bar  
Reactivate Qual Card 
Qual Card Admin tab  
Remove Document  
Review Competency form > Supporting 
Documentation  
Remove Qual 
Qual Direction tab > Assigned Quals  

Request Due Date Extension 
 

Review Due Date Extension  
 

Start Qual Card 
Participant tab  

Submit for Equivalency 
 

Submit for Final Qualifying Activities 
 

Submit for Review 
 

Undo Expire 
 

View Details 
 

View Document 
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eTQP Icons 

Action Icon 

View/Edit Submission  
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7.0 eTQP MANAGER 

The eTQP Manager performs the following activities in the eTQP tool: 

• Assigns site personnel to the appropriate eTQP roles (Participant, Supervisor, QO, 
Equivalency Reviewer, FTCP Agent) 

• Sets up subordinate sites if applicable 

• Sets up the site’s QO-to-competency matrix 

• Enters site-specific quals and competencies in eTQP  

• Initiates and assigns new qualification and requalification activities (qual directions) 

• Coordinates final qualifying activities for Participants 

• Assists Participants during qualification and requalification activities 

• Enters legacy quals completed outside of eTQP 

7.1 Set Up a Site 

The NTC eTQP Administrator adds each eTQP site and its associated eTQP Manager to 
eTQP. 

The site’s eTQP Manager assigns users to the appropriate site roles and adds site-
specific qual cards to the site. The eTQP Manager can also establish subordinate eTQP 
sites as applicable. 

7.1.1 Create a Subordinate Site 

1. Select the Sites tab to display a list of the sites managed by the logged-in eTQP 
Manager. 

2. Click New Site to open the New Site form. 
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3. On the New Site form, fill in the Title and Field Office fields and select a site in the 
Parent Site list.  

 

7.1.2 Assign Users to Site Roles 

To do this: Do this: 

Assign users to roles in the new site you 
created in Section 7.1.1  Continue working in the New Site page. 

Assign users to roles in an existing site  Click the site’s Edit icon on the Sites tab to open 
the Edit Site page. 

 

NOTE: Before assigning users to site roles, review the table in Section 5.2 that 
summarizes the responsibilities associated with each eTQP role, and review 
the note in Section 5.1 about eTQP roles and job titles. 
 
A user cannot be assigned to the Participant role at more than one site at a 
time. If a user who is a Participant at one site is added as a Participant at 
another site, an error message will be displayed. 

 

IMPORTANT: Before assigning users to the Qualifying Official (QO) role, review 
Section 7.4, Managing Qualifying Officials and Equivalency 
Reviewers. 

1. To assign one or more users to a site role, select the tab for that role, and then click 
Add to open the Select User form. 
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2. Select the check box next to the name of each user to be added to the selected role.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   

NOTE: The Select User list contains entries for everyone with an active eAccess 
account, not just those active in TQP at a specific site. Be sure to select the 
correct name or names for each role, as there may be several individuals in 
the system with the same name. 
 
The easiest way to find a name in the list of active accounts is to filter the 
list by a few consecutive letters from the person's email address.   

 

3. Click Submit on the Select User form to add the selected users to the current role. 

4. Repeat Steps 1 through 3 to add users to each role as appropriate. 

5. When you are finished adding users to site roles, click Submit on the New Site form 
to return to the Sites tab. 

NOTE: Always click Submit to save your changes before leaving a form. 

7.1.3 Remove Individuals from Site Roles  

1. On the Sites tab, click the Edit icon for the relevant site.  

2. On the Edit Site form, select the tab for the relevant role. 
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3. Locate the individual to be removed from the selected role, and then click the Delete 
icon for that individual.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   

 

4. Click OK in the confirmation dialog box for each deletion. 

5.  Click Submit to return to the Sites tab. 
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7.2 Manage Site Participants 

The Participants tab lists all participants assigned to an eTQP Manager’s site and 
allows the Manager to review and edit information associated with each Participant. 

NOTE: If you are also a QO, be sure to conduct all qual card sign offs and final reviews 
from the Qual Card Admin tab, not the Participants tab. Although eTQP 
Managers can access qual cards from the Participants tab, QO sign offs and 
the final review process are programmed to occur through the Qual Card 
Admin tab. 

7.2.1 Manage a Participant’s Supervisor 

1. Locate the relevant Participant on the Participants tab and click the Edit button. 

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   

 

2. To set either the 1st Line Supervisor or the 2nd Line Supervisor, click Edit 
Supervisor under the correct role in the Participant’s profile window. 

3. Check the box next to the correct user in the Select User list, and then click Submit. 
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7.2.2 Transfer a Participant to Another Site 

A user who transfers from one site to another must be removed from the Participant role 
at the original site before being added to the Participant role at the transfer site. All qual 
data for the Participant is preserved and available at the transfer site. 

NOTE: A user cannot be assigned to the Participant role at more than one site at a 
time. If a user who is a Participant at one site is added as a Participant at 
another site, an error message will be displayed. 

7.2.2.1 Remove the Participant from the Original Site 

The eTQP Manager at the original site must remove the individual from the Participant 
role at that site. 

1. On the Sites tab, click the Edit icon for the relevant site.  

2. On the Edit Site form, select the Participants tab. 

3. Locate the individual to be removed from the selected role, and then click the Delete 
icon for that individual.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   

 

4. Click OK in the confirmation dialog box. 
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5.  Click Submit to return to the Sites tab. 

7.2.2.2 Add the Participant to the Transfer Site 

After the Participant has been removed from the Participants role at the original site, the 
eTQP Manager at the transfer site must add the individual to the Participants role at that 
site. 

1. On the Sites tab, click the Edit icon for the relevant site.  

2. On the Edit Site form, select the Participants tab. 

3. Click Add to open the Select User form. 

 

4. Select the check box next to the name of the individual to be added to the transfer 
site.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 
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NOTE: The Select User list contains entries for everyone with an active eAccess 
account, not just those active in TQP at a specific site. Be sure to select the 
correct name for the transferring user, as there may be several individuals 
in the system with the same name. 
 
The easiest way to find a name in the list of active accounts is to filter the 
list by a few consecutive letters from the person's email address.   

5. Click Submit on the Select User form to add the selected user to the Participants 
role. 

NOTE: Always click Submit to save your changes before leaving a form. 
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7.3 Manage Site Quals 

The eTQP Manager creates legacy and site-specific quals; adds and edits competencies 
for new and existing quals; assigns available QOs to specific competencies; and 
discontinues, disables, and reinstates existing qual cards.  

A list of all quals associated with the current site and its parent and subordinate sites is 
displayed on the Quals tab. The eTQP Manager can manage quals for his or her own 
site and any subordinate sites. 

7.3.1 Set Up a Site-Specific Qual  

1. On the Quals tab, click New Qual to open the New Qual form. 

 

2. Complete the following items on the New Qual form: 

a. Enter a name for the qual in the Qual Title field. 

b. Select the qual’s parent site from the Parent Site list. 

c. Enter a link to the relevant standard in the Qual Standard URL field (optional). 
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d. Enter a comment in the Notes field (optional). 

 

3. Add competencies to the new qual (see Section 7.3.2). 

4. When all competencies have been added, click Submit to return to the Quals tab. 
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7.3.2 Add Competencies 

To do this: Do this: 

Add competencies to the new qual you 
created in Section 7.3.1  Continue working in the New Qual page. 

Add competencies to an existing qual  Click the qual’s Edit icon on the Quals tab to 
open the Edit Qual page. 

 

1. Click  Add Competency. 

 

2. Complete the following items in the Add Competency area. 

a. Enter the competency number in the # field. 

• Competencies can be numbered using any alphanumeric or outline 
numbering scheme.  

• To sort the competencies correctly, the numbering scheme and punctuation 
must remain consistent throughout the competency list. 

b. Select the appropriate competency level from the Level list. 

c. Enter a description of the competency in the Competency field. 

d. Click Insert to add the new competency to the qual. 

3. Repeat Steps 1 and 2 for each competency. 
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4. When all competencies have been added, click Submit to close the New Qual or 
Edit Qual page.  

 

• The new qual is displayed in the site’s list of quals. 

7.3.3 Edit a Competency 

1. On the Quals tab, click the Edit icon of the qual containing the competency to be 
edited. 
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2. On the Edit Qual form, click the Edit icon of the relevant competency to open the 
competency for editing. 

 

3. Update the competency level and description as needed, and then click Update to 
save the edits and close the competency for editing. 

4. When editing is complete, click Submit to return to the Quals tab. 

7.3.4 Clone a Qual Card 

A cloned qual card can be modified for use at a different facility, site, or position. 

1. On the Quals tab, click the Clone icon next to the qual to be cloned. 

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 
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4. In the Clone Target dialog box, select the site that owns the newly cloned qual from 
the Parent Site list.  

 

5. Click Submit to display the newly cloned qual in the list of quals. 

7.3.5 Discontinue, Disable, or Reinstate a Qual Card 

The eTQP Manager can discontinue (expire), temporarily disable, or reinstate a site-
specific qual card.  

NOTE: If the qual being expired or disabled is currently assigned to any Participants, a 
notification email is sent to those Participants and their First Line Supervisors. 

1. Select the Quals tab to display a list of quals for the parent site and any subordinate 
sites. 

2. Locate the qual to be expired, disabled, or reinstated. 

• To sort the list of quals, click the Qual Title or Site column heading.  

  eTQP BASICS See Section 6.1.2 for help on sorting 
items in a list. 

   

 

• To expire a qual, click the Expire icon.  
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The Expire flag changes to red and the word “Expired” appears next to the qual 
title. 

• To reinstate an expired qual, click the Undo Expire icon.  

 

The Undo Expire flag changes to green and the word “Expired” disappears from 
the qual title. 

• To disable a qual, click the Disable icon.  

 

The Disable toggle button changes to red and the word “Disabled” appears next 
to the qual title. 

• To reinstate a disabled qual, click the Enable icon.  

 

The Enable toggle button changes to green and the word “Disabled” disappears 
from the qual title. 

7.3.6 Delete a Qual Card 

A qual card that has not yet been assigned to a Participant, or that has been assigned 
but not yet accepted and started by the Participant, can be deleted only by an eTQP 
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Manager logged in to the DOE NTC site. Contact the NTC at 505-845-2001 (option 3) or 
etqpsupport@ntc.doe.gov for assistance.  

NOTE: Deletion of a qual is a permanent operation. A deleted qual cannot be restored. 

7.3.7 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards for all site participants is displayed on the 
Qual Card Admin tab. The eTQP Manager can export this list to an Excel spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported. 

1. Select the Qual Card Admin tab to display the list of assigned qual cards.  

2. If necessary, click a column heading to sort the list by Participant, qual title, the 
supervisor who directed the qual assignment, or the qual card due date. 

3. Click the Export to Excel icon.  

 

4. In the confirmation dialog box, click Open or Save. 

 

5. eTQP creates a spreadsheet named “RadGridExport.xls.”  

• If you selected Open, the spreadsheet opens in Microsoft Excel. 

• If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

mailto:etqpsupport@ntc.doe.gov
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• If you selected Save, the spreadsheet is saved to the user’s Downloads folder. 
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7.4 Manage QOs and Equivalency Reviewers 

A list of all QOs added to the current site and its parent and subordinate sites is 
displayed on the Qualifying Officials tab. These QOs are available for selection when 
participants submit competencies for review. QOs added at the Program Office level and 
assigned to GTB- and FAQS-based competencies are also available for selection by 
participants.  

In addition, QOs authorized to approve equivalencies are also listed on the site’s 
Equivalency Reviewers tab. (See Section 7.4.2, Equivalency Reviewers.) 

Each QO or Equivalency Reviewer is authorized to sign off only on his or her assigned 
competencies. The eTQP Manager can manage QOs and Equivalency Reviewers for his 
or her own site and any subordinate sites.  

IMPORTANT: Before assigning users to the QO role or adding/removing competencies 
for a QO, review Section 7.4.1, Qualifying Officials: Program Office vs. 
Site-Level. 

To add QOs and Equivalency Reviewers to a site, see Section 7.1.2, Assign Users to 
Site Roles. 

7.4.1 Qualifying Officials: Program Office vs. Site-Level  

Program Office QOs: Individuals authorized by a Program Office to sign off on 
assigned GTB- and FAQS-based competencies 

Site-Level QOs: Individuals authorized at a site to sign off on assigned site-specific 
competencies as well as assigned GTB- and FAQS-based competencies  

• Each site should add their QOs to the site-level QO listing in order to place their 
names at the top of QO selection lists. 

• Sites that do not have QOs assigned by a Program Office must assign site-level 
QOs to GTB and FAQS competencies. 

• Site-level QOs are added to the site database and assigned competencies by the 
eTQP Manager. 

NOTE: Program Office QOs may also be added to a site and assigned site-specific 
competencies by the eTQP Manager. The eTQP Manager should coordinate 
with the applicable TQP Program Office prior to changing QO competency 
assignments. 
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NOTE: To view a list of all site-level and Program Office QOs and their assigned 
competencies, see Section 7.4.6, Export a List of All Available QOs and 
Equivalency Reviewers and Assigned Competencies.  

7.4.2 Equivalency Reviewers 

Equivalency Reviewers are QOs who are also authorized to approve equivalency 
requests for specific competencies. Equivalency Reviewers must be added to the 
Equivalency Reviewer role for the site before they are available for selection when 
participants submit equivalencies for review. See Section 7.1.2, Assign Users to Site 
Roles for more information. 

Equivalency Reviewers are listed on the Qualifying Officials tab and are assigned 
competencies in the same way as QOs. For more information, see Section 7.4.4, Assign 
Competencies to a Qualifying Official or Equivalency Reviewer. 

NOTE: Most Equivalency Reviewers are also QOs. However, it is possible to be an 
Equivalency Reviewer without also being a QO. 

7.4.3 View the Competencies Assigned to a QO or Equivalency Reviewer Added to the 
Site 

NOTE: Equivalency Reviewers are listed on the Qualifying Officials tab. For more 
information, see Section 7.4.2, Equivalency Reviewers. 

1. On the Qualifying Officials tab, click the Manage Competencies icon for the 
relevant QO or Equivalency Reviewer to open the QO’s Qualified Competencies 
form. 
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2. Competencies assigned to the current QO or Equivalency Reviewer are checked and 
highlighted, and appear at the top of the list on the QO's Qualified Competencies 
form. 

 

7.4.4 Assign Competencies to a QO or Equivalency Reviewer 

NOTE: Do not add or remove GTB- or FAQS-based competencies for QOs set up at 
the Program Office level.  
 
Before assigning competencies for any QOs, review Section 7.4.1, Qualifying 
Officials: Program Office vs. Site-Level. 

  

NOTE: Equivalency Reviewers are listed on the Qualifying Officials tab. For more 
information, see Section 7.4.2, Equivalency Reviewers. 

1. On the Qualifying Officials tab, click the Manage Competencies icon for the 
relevant QO or Equivalency Reviewer to open the QO’s Qualified Competencies 
form. 
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2. The QO's Qualified Competencies page displays a list of the competencies for all 
the quals managed by the logged-in eTQP Manager.  

• Competencies already assigned to the current QO or Equivalency Reviewer are 
checked and highlighted. 

 

3. Locate the competencies to assign to the current QO or Equivalency Reviewer by 
filtering, sorting, or scrolling through the list.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   
• To show only the competencies for a specific qual, type a few characters from 

the qual title or standard number in the Qual filter box, and then click the Filter 
icon. 
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• To show only the competencies for a specific site, type a few characters from the 
site name in the Site filter box, and then click the Filter icon. 

 

• To show only the competencies with a specific word or phrase in the title, type 
the word or phrase in the Competencies filter box, and then click the Filter icon. 

 

• To sort the list in ascending order by qual title, click the Qual column heading. 

To sort in descending order, click the Qual column heading a second time. 
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• Use the page navigation bar at the bottom of the list to scroll through the 
complete, sorted, or filtered list.  

 

4. Check the box for each competency to assign to the current QO or Equivalency 
Reviewer.  

• Each checked competency is highlighted. 
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5. Click Submit to return to the Qualifying Officials tab. 

6. Click the Edit icon for the same QO or Equivalency Reviewer to display the complete 
list of assigned competencies. 

7.4.5 Remove a Competency for a QO or Equivalency Reviewer 

NOTE: Do not add or remove GTB- or FAQS-based competencies for QOs set up at 
the Program Office level.  
 
Before removing competencies for any QO, review Section 7.4.1, Qualifying 
Officials: Program Office vs. Site-Level. 

 

NOTE: Equivalency Reviewers are listed on the Qualifying Officials tab. For more 
information, see Section 7.4.2, Equivalency Reviewers. 

1. On the Qualifying Officials tab, click the Manage Competencies icon for the 
relevant QO or Equivalency Reviewer to open the QO’s Qualified Competencies 
form. 
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2. The QO's Qualified Competencies page displays a list of the competencies for all 
the quals managed by the logged-in eTQP Manager.  

• Competencies already assigned to the current QO or Equivalency Reviewer are 
checked and highlighted. 

 

3. Locate the competencies to remove for the current QO or Equivalency Reviewer by 
filtering, sorting, or scrolling through the list.  

  eTQP BASICS See Section 6.1 for help on locating 
items in a list. 

   
4. Uncheck the box for each competency to be removed from the QO or Equivalency 

Reviewer’s list. 

5. Click Submit to return to the Qualifying Officials tab. 

7.4.6 Export a List of All Available QOs and Equivalency Reviewers and Assigned 
Competencies 

The eTQP Manager can export a list of all available Program Office and site-level QOs 
and Equivalency Reviewers and their assigned competencies to an Excel spreadsheet. 
The spreadsheet lists all QOs and Equivalency Reviewers and assigned competencies 
that are available to the site. 

The exported list can be sorted and filtered by QO/Equivalency Reviewer name, qual 
title, and qualification site (the site where the qual card and its competencies were set up 
in eTQP).  

NOTE: All GTB quals and quals based on FAQS were set up by the NTC and will show 
“DOE NTC” as the qualification site in the exported list. Site-specific quals (see 
Section 7.3.1) will show the local site name as the qualification site. 
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NOTE: Equivalency Reviewers are listed on the Qualifying Officials tab. For more 
information, see Section 7.4.2, Equivalency Reviewers. 

1. Select the Qualifying Officials tab to display the list of the site’s qualifying officials.  

2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “QualifyingOfficialComps.xls.”  

• If you selected Open, the spreadsheet opens in Microsoft Excel. 

• If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

• If you selected Save, the spreadsheet is saved to the user’s Downloads folder. 

7.4.6.1 Sort the Exported Spreadsheet 

1. On the Data tab in Microsoft Excel, click Sort. 
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2. In the Sort dialog box, select a column to sort by and specify the whether to sort 
the values in ascending (A to Z) or descending (Z to A) order. 

3. To sort by multiple columns, click Add Level and repeat Step 2 for each 
additional column. 

 

3. Click OK. 

7.4.6.2 Filter the Exported Spreadsheet 

1. On the Data tab in Microsoft Excel, click Filter. 

 

2. Click the filter button that appears to the right of the column header to filter the 
list by.  

3. In the filter menu, uncheck the Select All check box, and then check the box 
next to each value to include in the filtered list. 
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4. Click OK. 

7.4.7 Export a List of Competencies for a Single QO or Equivalency Reviewer 

The eTQP Manager can export a list of the competencies assigned to a single QO or 
Equivalency Reviewer to an Excel spreadsheet. The spreadsheet lists all of the 
QO/Equivalency Reviewer’s assigned competencies and can be sorted and filtered by 
qual title.  

NOTE: Equivalency Reviewers are listed on the Qualifying Officials tab. For more 
information, see Section 7.4.2, Equivalency Reviewers. 

1. Select the Qualifying Officials tab to display the list of the site’s QOs and 
Equivalency Reviewers.  

2. Click the Export QO’s Competencies to Excel icon for the relevant QO or 
Equivalency Reviewer.  

 

3. In the confirmation dialog box, click Open or Save. 
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4. eTQP creates a spreadsheet named “QOCompetencies.xls.”  

• If you selected Open, the spreadsheet opens in Microsoft Excel. 

• If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

• If you selected Save, the spreadsheet is saved to the user’s Downloads folder. 

To sort or filter the exported spreadsheet, see Sections 7.4.6.1 and 7.4.6.2. 
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7.5 Manage Participant Quals 

7.5.1 Initiate and Assign a New Qual Direction 

New qual directions are initiated and assigned on the Qual Directions tab. Qual 
directions displayed on this tab have been initiated but not yet assigned to Participants 
managed by the logged-in eTQP Manager.  

NOTE: A “short form” version of the General Technical Base (GTB) qual is available for 
individuals who have completed the GTB eLearning course online. This qual 
requires a single signature and attachment of the certificate of completion from 
the eLearning course. It may be used where appropriate in place of the 
standard GTB qual. 
 

 

1. On the Qual Directions tab, click New Qual Direction to open the Initiate 
Qualification form. 

• A list of the Participants managed by the logged-in eTQP Manager is displayed. 
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2. Click the Initiate Qual Direction icon for the appropriate Participant to open the 
Qual Direction form. 

  eTQP BASICS See Section 6.1 for help on locating a 
Participant in a list. 

   

 

3. Complete the following items on the Qual Direction form.  

 

a. Click the Calendar icon to set a due date for this qual direction.  

• A qual direction can’t be assigned without a due date. 

• Due-date reminder notifications are sent to eTQP Managers, Supervisors, 
and Participants at 180 days, 90 days, and 45 days prior to the assigned due 
date. 
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NOTE: The selected due date applies to all quals included in this qual direction. 
To apply a different due date to one or more quals, a different qual 
direction must be created for those quals. 
 
The Participant can request a due date extension for each qual 
individually after accepting the qual direction.  

b. Click Add Files to add supporting documentation.  

NOTE: Supporting documentation uploaded on the Qual Direction form 
applies to all quals included in this qual direction. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   
c. Click Add Quals to select the quals to include in this qual direction.  

5. On the Choose Quals for Qual Direction form, select the check box next to each 
qual to be included.  

• Quals can be added from multiple pages in the list of available quals.  
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6. Click Submit to close the Choose Quals for Qual Direction form.  

• The selected quals are added to the Assigned Quals list in the current qual 
direction. 

 

7. If one of the selected quals is a Senior Technical Safety Manager qual, select an 
FTCP Agent to review the final qualifying activities. 

 

NOTE: If none of the selected quals is a Senior Technical Safety Manager qual, the 
Select FTCP Agent field does not appear on the Qual Direction form. 
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8. Click Submit to close the Qual Direction form.  

• The new qual direction is displayed in the list of directed quals on the Qual 
Directions tab. 

 

9. To add or remove quals, change the due date, or add or remove supporting 
documents, click the Edit icon for the relevant qual direction to open the Qual 
Direction form and repeat Steps 3 through 8 as needed. 

 

10. Click the Assign Qual Card icon to finalize the qual direction and notify the 
Participant that one or more qual cards have been assigned. 

NOTE: If the Assign Qual Card icon is not visible, no due date has been set for 
this qual direction. 
 
Click the Edit icon to return to the Qual Direction form and set the due 
date. 
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11. Click OK in the message box to notify the Participant and Supervisor that the qual 
card has been assigned.  

 

12. The assigned qual direction is removed from the Qual Directions tab.  

• The qual cards contained in the qual direction are displayed on the Qual Card 
Admin tab. 
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• The qual cards are also displayed on the Qual Cards tab on the Participant’s 
profile page. 

  

NOTE: To delete a qual card assigned to a Participant in error, see Section 7.5.6, 
Delete a Participant’s Qual Card.  
 
To inactivate a qual card that is no longer relevant for a Participant, see 
Section 7.5.8, Inactivate and Reactivate a Qual Card. 

7.5.2 Change the Qualifying Official Requested for a Competency Review 

When a Participant requests a competency review, the eTQP Manager, the Supervisor, 
and the Participant all have the option of selecting a different QO to perform the review 
than the one specified by the Participant. 

This change may be made at the eTQP Manager’s or Supervisor’s discretion because 
the requested QO is not available, or because the Manager or Supervisor prefers a 
different QO for a specific circumstance.  

1. On the Qual Card Admin tab, locate the relevant qual and competency. 
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  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. Click the competency’s Edit icon to open the Review Competency form. 

 

3. To select a different QO to review the competency, complete the following items in 
the Review Competency form: 

a. Select the preferred QO from the Change Reviewer list. 

b. Enter any notes in the Notes field. 

c. Add supporting documentation. 
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IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   
4. Click Submit to close the Review Competency form. 

• The new QO’s name appears in the Reviewer column, and the competency’s 
status changes to <QO Name> Reviewing. 

7.5.3 View the Status and Review History of a Competency, Equivalency, or Active or 
Completed Qual 

The status and history of all quals administered by the logged-in eTQP Manager, and all 
associated competencies and equivalencies, can be reviewed from the Qual Card 
Admin tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the eTQP Manager who directed the 
assignment of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
Participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• The review history is not available for competency or equivalency review requests 
that are currently in progress, but notes and supporting documentation can be 
reviewed. 
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7.5.3.1 View the Review History of a Competency or Equivalency 

1. Select the Qual Card Admin tab to display the qual cards administered by the 
logged-in eTQP Manager. 

OR 

Select the Participants tab to display the participants administered by the 
logged-in Manager. 

2. Locate the qual card containing the competency to be reviewed.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
3. Click the Expand icon for the relevant qual card to display the qual card’s 

competencies. 
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4. Click the View Details icon next to a competency that has been completed or 
kicked back to open the Review Competency or Review Equivalency form. 

 

5. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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6. Click Close to return to the list of quals and competencies.  
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7.5.3.2 Print the Status of All Competencies in an Active Qual Card 

1. Select the Qual Card Admin tab to display the qual cards administered by the 
logged-in eTQP Manager. 

OR 

Select the Participants tab to display the participants administered by the 
logged-in Manager. 

2. Locate the appropriate qual card, and click the Print icon to the right of the qual 
title. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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3. A printable list of the competencies, including the reviewer name, history, and 
current status of each competency, opens in a separate tab. 

 

4. Click Print to print the list of competencies. 
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7.5.3.3 View the Review History of a Completed Qual Card 

NOTE:  Review history is not currently available for quals that have been 
deactivated. 

1. Select the Qual Card Admin tab to display the qual cards administered by the 
logged-in eTQP Manager. 

OR 

Select the Participants tab to display the participants administered by the 
logged-in Manager. 

2. Click the View Details icon next to the completed qual card to be reviewed to 
open the Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

3. In the Qual Card Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  
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• First and Second Line Supervisor names and Review Results 

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

4. Click Close to return to the list of quals.  

7.5.4 Review Final Qualifying Activities 

After the Participant completes all competencies for a qual card, the eTQP Manager 
coordinates the final qualifying activities for the qual (examination, facility walk-through, 
oral board, and/or oral interview) with the Participant and any other parties involved.  

When the final qualifying activities are complete, the eTQP Manager uploads supporting 
documentation and submits the results for final review and approval by the appropriate 
Supervisor or Supervisors. 
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1. Select the Qual Card Admin tab to display a list of quals administered by the 
logged-in eTQP Manager.  

• Quals available for review have a status of <Manager Name> Reviewing and an 
Edit Submission icon in the Actions column. 

 

2. Click the Edit Submission icon for the relevant qual card to open the Review Qual 
Card form. 

3. Complete the following items on the Review Qual Card form:  

• To approve the final qualifying activities:  

a. Select the appropriate evaluation methods in the Evaluation Method list. 

b. Select Accept in the Review Result list. 

c. Check the box certifying that the candidate has successfully completed the 
qual. 

d. Document the decision in the Notes field. 

e. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation 

   
• To kick back the qual:  

a. Select Kick Back in the Review Result list.  

b. Document the decision in the Notes field.  

c. Add supporting documentation. 
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IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

NOTE: The Kick Back result constitutes a denial of the request for approval. It can 
also allow the reviewer to request the submission of additional information 
by the Participant.  

 

4. Click Submit to close the Review Qual Card form.  

• The Edit Submission icon no longer appears with the qual. 

• If the final qualifying activities were accepted, the First Line Supervisor is notified 
to review the qual and the qual’s status is shown as <Supervisor Name> 
Reviewing.  

• If the qual was kicked back, the qual’s status is shown as Kicked Back, and the 
Participant has the option of submitting it for review and approval again. 
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7.5.5 Load Legacy Qual Completions for Participants 

Quals completed by eTQP Participants before the eTQP tool became available 
(November, 2014) are loaded in eTQP as “legacy quals” by the eTQP Manager. Other 
TQP records may also be loaded for legacy quals, including exams, board results, and 
walk-through results.  

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP.  
Remember that exams may be classified, so check before uploading 
exams as supporting documents. 

The eTQP tool contains only active qual standards. If a Participant completed a qual on 
a previous (superseded) qual standard, the eTQP Manager must set up the legacy qual 
in eTQP. This makes it available in the list of quals to be loaded in each Participant’s 
profile. 

7.5.5.1 Set Up a Legacy Qual 

A legacy qual has a title, but it has no associated competencies.  

NOTE: Do not add competencies for legacy quals. 

1. On the Quals tab, click New Qual to open the New Qual form. 
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2. On the New Qual form, complete the following items: 

a. Enter a name for the legacy qual in the Qual Title field. 

b. Select the qual’s parent site from the Parent Site list. 

c. Enter a link to the relevant standard in the Qual Standard URL field 
(optional). 

d. Enter a comment in the Notes field (optional). 

e. Do not add any competencies. 

 

3. Click Submit to return to the Quals tab. 
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7.5.5.2 Load a Legacy Qual Card for a Participant 

1. On the Sites tab, click the Edit icon for the relevant site to open the Edit Site 
form. 

 

2. Select the site’s Participants tab to view a list of Participants assigned to the 
selected site, and then click the Load Legacy Qual Cards icon for the relevant 
Participant to open the Legacy Qual Cards form. 

 

3. Click Add to open the Legacy Qual Card Load form. 

 

4. Complete the following items on the Legacy Qual Card Load form:  

a. Select the completed qual in the Select a Qualification Standard list.  

b. Click the Calendar icon next to the Completed Date field to select the date 
that the legacy qual was completed. 

c. The names of the Participant's current First Line Supervisor and Second Line 
Supervisor (if applicable) are automatically populated on the form.  
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• To change either supervisor, click Edit Supervisor and select the 
appropriate name. 

NOTE: If the Participant does not have a Second Line Supervisor, leave 
the field blank. Do not enter the name of the First Line 
Supervisor twice by adding it to the Second Line Supervisor 
field.   

d. Add supporting documentation. 

NOTE: Supporting documentation is required to load a legacy qual card. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

 

5. Click Submit to close the Legacy Qual Card Load form and display the newly 
loaded qual on the Legacy Qual Cards page. 

 

6. Click Submit to return to the Qual Card Admin page.  
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7. All newly loaded legacy qual cards are displayed in the list.  

• The status of legacy qual cards is shown as Complete (Legacy). 

 

7.5.6 Delete a Participant’s Qual Card 

If a qual card was assigned to a Participant in error, the Participant’s Manager can 
delete the qual card only if it has a card status of Not Started.  

• If the card status is In Progress, Complete, or Complete (Legacy), the qual card 
cannot be deleted. 

NOTE: Deletion of a Participant’s qual card is a permanent operation. A deleted qual 
card cannot be restored. 

1. On the Qual Card Admin tab, locate the qual card to be deleted. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
2. Click the Delete icon. 

 

3. Click OK to confirm the deletion. 
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7.5.7 View Current (Active) and Historical (Inactivated) Qual Cards 

By default, the Qual Card Admin tab displays only active qual cards, which are visible in 
the Current view.  

NOTE: To inactivate and reactivate qual cards, see Section 7.5.8. 

• To view inactivated qual cards, select Historical in the View menu. 

• To view active qual cards, select Current in the View menu. 

• To view all active and inactivated qual cards, select All in the View menu. 

 

7.5.8 Inactivate and Reactivate a Qual Card 

If a qual is longer relevant for a Participant, it can be inactivated by the Participant’s 
eTQP Manager.  

• Inactivated quals are not deleted from eTQP, but they do not appear in the Current 
view of the Qual Card Admin tab.  

• Inactivated quals appear in the Historical and All views of the tab and can be 
reactivated at any time. 

NOTE:  A manager can only inactivate or reactivate qual cards for Participants assigned 
to the site where he or she is logged in as eTQP Manager. 

7.5.8.1 Inactivate a Qual Card  

1. On the Qual Card Admin tab, select Current or All in the View menu. 
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2. Locate the qual card to be inactivated. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
3. Click the Inactivate icon. 

 

4. In the Inactivate Qual Card form, enter notes about the reason for inactivation.  

5. Click Submit to close the Inactivate Qual Card form. 

• The inactivated qual card no longer appears in the Current view of the Qual 
Card Admin tab. 

• To view the inactivated qual card, select Historical or All in the View menu. 

7.5.8.2 Reactivate a Qual Card  

1. On the Qual Card Admin tab, select Historical or All in the View menu. 

 

2. Locate the qual card to be reactivated. 

3. Click the Reactivate icon. 

 

4. In the Reactivate Qual Card form, enter notes about the reason for inactivation.  

5. Click Submit to close the Reactivate Qual Card form. 

• The inactivated qual card no longer appears in the Historical view of the 
Qual Card Admin tab. 

• To view the reactivated qual card, select Current or All in the View menu.  
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8.0 PARTICIPANT 

The eTQP Participant performs the following tasks in eTQP: 

• Reviews and accepts assigned qual directions 

• Completes qualification and requalification activities as assigned 

• Submits due date extension requests for assigned quals as appropriate 

• Documents and provides evidence of competency satisfaction as required by site 
procedures and requests evaluation by the QO 

• Documents and provides justification and objective evidence of competency 
equivalencies and requests equivalencies from the eTQP Reviewer 

• Uploads evidence and documentation to eTQP to support qualification 

• Coordinates final qualifying activities with the eTQP Manager 

All Participant activities take place on the Profile screen. 

8.1 Manage First and Second Line Supervisors 

1. Click Edit Supervisor for the appropriate Supervisor (First Line Supervisor or 
Second Line Supervisor). 

 

2. Locate the Supervisor's active eAccess account.  

  eTQP BASICS See Section 6.1 for help on locating a user 
in a list. 
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NOTE: The Select User list contains entries for everyone with an active eAccess 
account, not just those active in TQP at a specific site. Be sure to select the 
correct name or names, as there may be several individuals in the system 
with the same name. 
 
The easiest way to find a name in the list of active accounts is to filter the 
list by a few consecutive letters from the person's email address.   

3. Select the check box next to the Supervisor’s name, and then click Submit to add 
the selected user as the First Line or Second Line Supervisor. 

 

4. Repeat Steps 1 through 3 to add a Second Line Supervisor, if applicable. 

NOTE: If you do not have a Second Line Supervisor, leave the field blank.  
Do not enter the name of your First Line Supervisor twice by adding it to the 
Second Line Supervisor field.   
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8.2 View Current (Active) and Historical (Inactivated) Qual Cards 

The list of a Participant’s completed, in-progress, and not-yet-started qual cards appears 
on the Qual Cards tab of the Profile screen. Qual cards that are no longer relevant and 
have been inactivated by the Participant’s Manager also appear in the Historical view of 
the Qual Cards tab. 

By default, the Qual Cards tab displays only active qual cards, which are visible in the 
Current view.  

• To view active qual cards, select Current in the View menu. 

• To view inactivated qual cards, select Historical in the View menu. 

• To view all active and inactivated qual cards, select All in the View menu. 
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8.3 Review and Start a Qual Card 

The list of a Participant’s completed, in-progress, and not-yet-started quals appears on 
the Profile screen underneath the Participant’s contact information and supervisors.  

8.3.1 Review the Associated FAQS  

• To review the qual’s associated FAQS, click the qual title link to open the Energy.gov 
web page containing the FAQS in a new browser tab. 

 

8.3.2 Start the Qual Card 

1. Click the Start Qual Card icon for the assigned qual.  

 

2. If a First Line Supervisor has not already been set, a message appears instructing 
the Participant to set one. See Section 8.1 for instructions. 

3. Click OK in the dialog box to start the qual card and notify the Supervisor and eTQP 
Manager.  
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• The Start Qual Card icon is replaced by the Request Due Date Extension icon, 
and the status of the accepted qual card changes to In Progress. 

 

4. To review the competencies associated with the qual, click the Expand icon to the 
left of the qual title to display the competencies below the title. 

 

• To sort the list of competencies by the values in a column, click the column 
heading. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 
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8.4 Request a Due Date Extension for a Qual Card 

Due date extension requests are reviewed and approved by the First Line Supervisor. 

NOTE: Due-date reminder notifications are sent to eTQP Managers, Supervisors, and 
Participants at 180 days, 90 days, and 45 days prior to the assigned due date. 

1. Select the Request Due Date Extension icon for the assigned qual card to open the 
Submit Request for Due Date Extension form. 

 

2. Complete the following items on the Submit Request for Due Date Extension form:  

a. Click the Calendar icon to select a new due date. 

b. Select the Manager who assigned the initial due date from the Reviewer list. 

c. Enter any notes in the Notes field. 

d. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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3. Click Submit to close the Submit Request for Due Date Extension form and return 
to the Profile screen.  

• The qual’s Request Due Date Extension icon no longer appears in the Actions 
column. 
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8.5 Submit a Competency for Review or Equivalency 

8.5.1 Submit a Competency for QO Review  

1. Click the qual’s Expand icon to display the associated competencies below the qual 
title. 

 

2. Click the Submit for Review icon (the green checkmark) for the selected 
competency to open the Submit Competency for Review form. 

 

3. Complete the following items on the Submit Competency for Review form:  

a. Select the appropriate QO from the Reviewer list.  

NOTE: The QOs who are authorized to work at your site appear alphabetically 
at the beginning of the list, followed by QOs at all other sites. Be sure to 
select a QO who is authorized to work at your site. 
 
You may change the requested QO at any time. 

b. Enter notes in the Notes field. 

c. Add supporting documentation. 

• Select the All for This Qual Card tab to review already uploaded files. It is 
not necessary to resubmit files that have already been submitted. 

• Add new files on the For This Competency tab. 
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IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

4. Click Submit to return to the Profile screen.  

• The qual’s Submit for Review icon is replaced by the View/Edit Submission 
and View Details icons. 

• The status of the competency changes to <Reviewer’s Name> Reviewing. 

• The selected QO is notified of the pending competency review request. 
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NOTE: If you realize that you selected an incorrect QO as the reviewer for this 
competency, you may change the requested QO at any time. 

8.5.2 Submit a Competency for Equivalency Review  

1. Click the qual’s Expand icon to display the associated competencies below the qual 
title. 

 

2. Click the Submit for Equivalency icon (the blue checkmark) for the selected 
competency to open the Submit Equivalency for Review form. 

 

3. Complete the following items on the Submit Equivalency for Review form:  

a. Select the appropriate equivalency reviewer from the Reviewer list.  

b. Enter comments in the Notes field. 

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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4. Click Submit to return to the Profile screen.  

• The qual’s Submit for Equivalency icon is replaced by the View/Edit 
Submission and View Details icons. 

• The status of the competency changes to <Reviewer’s Name> Reviewing. 

• The eTQP Equivalency Reviewer is notified of the pending equivalency request. 
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8.6 Submit a Qual for Final Qualifying Activities 

A qual is not complete, and may not be submitted for final qualifying activities, until all 
competencies on the qual have been reviewed and approved.  

NOTE: When a qual is complete, the progress bar is green and displays 100%, and 
the card status is shown as Ready for Final Qualifying Activities. 

1. Click the Submit for Final Qualifying Activities icon for a completed qual. 

 

2. In the confirmation dialog box, click OK to open the Submit for Final Qualifying 
Activities form. 

 

3. Complete the following items on the Submit for Final Qualifying Activities form:  

a. Select a reviewer from the Reviewer list. 

b. Enter any notes in the Notes field. 
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c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

NOTE: If this is a Senior Technical Safety Manager (STSM) qual, lines for FTCP Agent 
and FTCP Agent Review Result will appear below the 2nd Line Supervisor 
Review Result line. 

4. Click Submit to close the Submit for Final Qualifying Activities form and return to 
the list of quals. 

• The Submit for Final Qualifying Activities icon is replaced by the View/Edit 
Submission and View Details icons, and the status of the competency changes 
to <Reviewer’s Name> Reviewing.  

 



eTQP User Guide September 2017 

PARTICIPANT 
 

NON-PROPRIETARY INFORMATION 
This procedure was prepared by the Safety Training Department and is scheduled for review in August 2018. 

85 

8.7 View the Status and Review History of a Competency, Equivalency, or 
Completed Qual Card 

The history and status of all quals assigned to the logged-in Participant, and all 
associated competencies and equivalencies, can be reviewed from the Profile tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the supervisor who directed the assignment 
of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
Participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• Review history is not available for competency or equivalency review requests that 
are currently in progress, but notes and supporting documentation can be 
reviewed. 

8.7.1 View the Review History of a Competency or Equivalency  

1. On the Profile tab, click the Expand icon for the relevant qual card to display the 
qual card’s competencies. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
2. Click the View Details icon next to a competency that has been completed, is under 

review, or has been kicked back, to open the Review Competency or Review 
Equivalency form. 
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3. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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4. Click Close to close the Review Competency or Review Equivalency form and 
return to the list of quals and competencies.  

 

8.7.2 View the Review History of a Completed Qual Card 

1. Click the View Details icon next to the relevant completed qual card to open the 
Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. In the Qual Card Review History list, click the Expand icon next to a review action 
to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• First and Second Line Supervisor Names and Review Results 

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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3. Click Close to close the Review Qual Card form and return to the list of quals.  

8.7.3 Print the Status of All Competencies in an Active Qual Card 

1. On the Profile tab, locate the appropriate qual card and click the Print icon to the 
right of the qual title. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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2. A printable list of the competencies, including the reviewer name, history, and 
current status of each competency, opens in a separate tab. 

 

3. Click Print to print the list of competencies,. 
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8.8 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards for the logged-in Participant is displayed 
on the Profile tab. The Participant can export this list to an Excel spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported. 

1. If necessary, click a column heading to sort the list by qual title, the supervisor who 
directed the qual assignment, or the due date. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “RadGridExport.xls.” 

• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 
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5. If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 
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9.0 SUPERVISOR (FIRST LINE and SECOND LINE SUPERVISORS) 

The Supervisor role in eTQP encompasses the responsibilities of both a First Line 
Supervisor and a Second Line Supervisor (if a Participant has one).  

The First Line Supervisor is responsible for the following activities in eTQP: 

• Reviewing and approving due date extension requests for assigned quals 

• Changing the QO requested for a competency review if appropriate 

• Reviewing and approving final qualifying activities 

The Second Line Supervisor receives notifications of actions relating to the eTQP 
Participants within his or her organization. However, the Second Line Supervisor has 
only one responsibility in eTQP: 

• Reviewing and approving final qualifying activities after the First Line Supervisor 
has approved them 
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9.1 Review Due Date Extension Request for a Qual Card 

(Performed by First Line Supervisor) 

NOTE: Due-date reminder notifications are sent to eTQP Managers, Supervisors, and 
Participants at 180 days, 90 days, and 45 days prior to the assigned due date. 

1. Select the Qual Card Admin tab to display a list of qual cards available for 
administration by the logged-in Supervisor. 

2. Click the Review Due Date Extension icon for the relevant qual card to open the 
Review Due Date Extension Request form. 

 

3. Complete the following items on the Review Due Date Extension Request form:  

• To accept the due date extension request:  

a. Select Accept in the Supervisor Review Result list. 

b. Document the decision in the Notes field. 

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
• To kick back the due date extension request:  

a. Select Kick Back in the Supervisor Review Result list.  

b. Document the decision in the Notes field.  
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c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   

 

4. Click Submit to close the Review Due Date Extension Request form.  

• The Review Due Date Extension icon no longer appears with the qual in the list 
of quals. 

• If the due date extension request was accepted, the qual’s new due date is 
shown in the list.  

• If the extension request was kicked back, the qual’s original due date is shown in 
the list, and the Participant has the option of submitting a new due date extension 
request. 
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9.2 Review Final Qualifying Activities 

(Performed by both First Line Supervisor and Second Line Supervisor) 

Documentation supporting a Participant’s final qualifying activities (examination, facility 
walk-through, oral board, or oral interview) is uploaded by the eTQP Manager and 
submitted to the Supervisor or Supervisors for final review and approval.  

NOTE: If a Participant has both a First Line Supervisor and a Second Line Supervisor, 
the second Supervisor will be notified to review and approve the qual after the 
first Supervisor has approved it. These instructions apply to both Supervisors.  

1. On the Qual Card Admin tab, click the Edit Submission icon for the relevant qual 
to open the Review Qual Card form. 

 

2. Review the notes and documentation added by the Participant and Manager. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
3. Perform the appropriate evaluation. 

4. Complete the following items on the Review Qual Card form:  

• To approve the final qualifying activities:  

a. Select the evaluation method in the Evaluation Method list. 

b. Select Accept in the Review Result list. 

c. Check the box certifying that the candidate has successfully completed the 
qual. 

d. Document the decision in the Notes field. 
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e. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
• To kick back the qual:  

a. Select Kick Back in the Supervisor Review Result list.  

b. Document the decision in the Notes field.  

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   

NOTE: The Kick Back result constitutes a denial of the request for approval. It can 
also allow the reviewer to request the submission of additional information 
by the Participant.  
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5. Click Submit to close the Review Qual Card form.  

• The Edit Submission icon no longer appears with the qual in the list of quals. 

• If the final qualifying activities were accepted and an additional Supervisor is 
required to approve the qual, the second Supervisor is notified and the qual’s 
status is shown as <Supervisor Name> Reviewing.  

• If the final qualifying activities were accepted and no additional Supervisor is 
required to approve the qual, the qual’s status is shown as Complete.  

• If the qual was kicked back, the qual’s status is shown as Kicked Back, and the 
Participant has the option of submitting it for review and approval again. 

 



eTQP User Guide September 2017 

SUPERVISOR 
 

NON-PROPRIETARY INFORMATION 
This procedure was prepared by the Safety Training Department and is scheduled for review in August 2018. 

98 

9.3 Change the Qualifying Official Requested for a Competency Review 

(Performed by First Line Supervisor) 

When a Participant requests a competency review, both the eTQP Manager and the 
Supervisor have the option of selecting a different QO to perform the review than the 
one specified by the Participant. 

This change may be made at the eTQP Manager’s or Supervisor’s discretion because 
the requested QO is not available, or because the Manager or Supervisor prefers a 
different QO for a specific circumstance.  

1. On the Qual Card Admin tab, locate the relevant qual and competency. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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2. Click the competency’s Edit icon to open the Review Competency form. 

 

3. To select a different QO to review the competency, complete the following items in 
the Review Competency form: 

a. Select the preferred QO from the Change Reviewer list. 

b. Enter any notes in the Notes field. 

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   
4. Click Submit to close the Review Competency form. 

• The new QO’s name appears in the Reviewer column, and the competency’s 
status changes to <QO Name> Reviewing. 
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9.4 View the Review History of a Competency, Equivalency, or Completed Qual 
Card 

The history and status of all quals managed by the logged-in Supervisor, and all 
associated competencies and equivalencies, can be reviewed from the Qual Card 
Admin tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the supervisor who directed the assignment 
of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
Participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• Review history is not available for competency or equivalency review requests that 
are currently in progress, but notes and supporting documentation can be 
reviewed. 

9.4.1 View the Review History of a Competency or Equivalency  

1. On the Qual Card Admin tab, click the Expand icon for the relevant qual card to 
display the qual card’s competencies.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
2. Click the View Details icon next to a competency that has been completed, is under 

review, or has been kicked back, to open the Review Competency or Review 
Equivalency form. 
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3. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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4. To close the Review Competency or Review Equivalency form and return to the 
list of quals and competencies, click Close.  

9.4.2 View the Review History of a Completed Qual Card 

1. Click the View Details icon next to the completed qual card to be reviewed to open 
the Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. In the Qual Card Review History list, click the Expand icon next to a review action 
to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• First and Second Line Supervisor names and Review Results 

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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3. To close the Review Qual Card form and return to the list of quals, click Close.  

9.4.3 Print the Status of All Competencies in an Active Qual Card 

1. Select the Qual Card Admin tab to display the qual cards administered by the 
logged-in Supervisor. 

OR 

Select the Participants tab to display the participants administered by the 
logged-in Supervisor. 

2. Locate the appropriate qual card, and click the Print icon to the right of the qual 
title. 



eTQP User Guide September 2017 

SUPERVISOR 
 

NON-PROPRIETARY INFORMATION 
This procedure was prepared by the Safety Training Department and is scheduled for review in August 2018. 

104 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

3. A printable list of the competencies, including the reviewer name, history, and 
current status of each competency, opens in a separate tab. 
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3. Click Print to print the list of competencies,. 
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9.5 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards managed by the logged-in Supervisor is 
displayed on the Qual Card Admin tab. The supervisor can export this list to an Excel 
spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported.  

1. If necessary, click a column heading to sort the list by qual title, the supervisor who 
directed the qual assignment, or the due date. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “RadGridExport.xls.” 
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• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 

5. If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

9.6 Sort the List of Qual Cards 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
• To sort the list of qual cards by the values in one of the columns, click the 

appropriate column heading. 
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10.0 EQIVALENCY REVIEWER 

The Equivalency Reviewer performs the review and approval of equivalency requests 
from participants in eTQP. 

The person responsible for this review and approval at a site may be an FTCP agent, or 
may have a different site role or job title. The site’s eTQP Manager assigns the eTQP 
Equivalency Reviewer role to the appropriate individual or individuals based on actual 
responsibilities. 

10.1 Review an Equivalency Request 

All eTQP Equivalency Reviewer actions take place on the Qual Card Admin tab. 

NOTE: If you receive an equivalency request for a competency you are not authorized 
to approve, notify the Participant and eTQP Manager by email to select a 
different Equivalency Reviewer. Do not complete this process or kick back 
the equivalency request. 

1. Click the Expand icon for the relevant qual to display the qual’s competencies. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
2. Click the View/Edit Submission icon next to the competency being reviewed for 

equivalency to open the Review Equivalency form. 

 

3. Complete the following items on the Review Equivalency form:  

• To approve the equivalency:  

a. Select Accept in the Review Result list. 
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b. Document the decision in the Notes field. 

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
• To kick back the equivalency:  

a. Select Kick Back in the Review Result list.  

b. Document the decision in the Notes field.  

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   

NOTE: The Kick Back result constitutes a denial of the request for equivalency. It 
can also allow the reviewer to request the submission of additional 
information by the Participant.  
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4. Click Submit to close the Review Equivalency form. 

• The Edit icon no longer appears next to the competency. 

• If the equivalency request was accepted, the competency’s status is shown as 
Complete.  

• If the equivalency request was kicked back, the competency’s status is shown as 
Kicked Back, and the Participant has the option of submitting a new equivalency 
request. 
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10.2 View the Review History of a Competency, Equivalency, or Completed Qual 
Card 

The history and status of all quals managed by the logged-in Equivalency Reviewer, and 
all associated competencies and equivalencies, can be reviewed from the Qual Card 
Admin tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the Supervisor who directed the assignment 
of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
Participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• Review history is not available for competency or equivalency review requests that 
are currently in progress, but notes and supporting documentation can be 
reviewed. 

10.2.1 View the Review History of a Competency or Equivalency  

1. On the Qual Card Admin tab, click the Expand icon for the relevant qual card to 
display the qual card’s competencies.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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2. Click the View Details icon next to a competency that has been completed, is 
under review, or has been kicked back, to open the Review Competency or 
Review Equivalency form. 

3. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

4. To close the Review Competency or Review Equivalency form and return to 
the list of quals and competencies, click Close.  
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10.2.2 View the Review History of a Completed Qual Card 

1. Click the View Details icon next to the completed qual card to be reviewed to open 
the Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. In the Qual Card Review History list, click the Expand icon next to a review action 
to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• First and Second Line Supervisor names and Review Results 

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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3. To close the Review Qual Card form and return to the list of quals, click Close.  
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10.3 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards managed by the logged-in reviewer is 
displayed on the Qual Card Admin tab. The reviewer can export this list to an Excel 
spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported.  

1. If necessary, click a column heading to sort the list by qual title, the supervisor who 
directed the qual assignment, or the due date. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “RadGridExport.xls.” 
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• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 

5. If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

10.4 Sort the List of Qual Cards 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
• To sort the list of qual cards on the Qual Card Admin page by the values in one of 

the columns, click the appropriate column heading. 
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11.0 QUALIFYING OFFICIAL 

The QO performs the review and approval of competencies requested by eTQP 
Participants. The Participant, the Participant’s Manager, and the Participant’s Supervisor 
all have the option of selecting a different QO to review a competency at any time. 

All QO actions take place on the Qual Card Admin tab. 

NOTE: If you are also an eTQP Manager, be sure to conduct all qual card sign offs and 
final reviews from the Qual Card Admin tab, not the Participants tab. 
Although eTQP Managers can access qual cards from the Participants tab, 
QO sign offs and the final review process are programmed to occur through the 
Qual Card Admin tab. 

NOTE: When a Participant requests a competency review by a specific QO, a 
notification email is sent to both the QO and the Participant’s First Line 
Supervisor. 
 
The reviewing QO can access eTQP by clicking the link in the notification 
email, as shown below. The link opens in the users default browser. 
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11.1 Review a Submitted Competency for Completion 

NOTE: If you receive a request to review a competency that you are not authorized to 
approve, notify the Participant and eTQP Manager by email to select a different 
QO. Do not complete this process or kick back the competency request. 

 1. Click the Expand icon for the relevant qual to display the qual’s competencies. 

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   
2. Click the View/Edit Submission icon next to the competency to be reviewed to open 

the Review Competency form. 

 

3. Review uploaded documentation. 

• To review documentation uploaded for this competency, click the For This 
Competency tab. 

 



eTQP User Guide September 2017 

QUALIFYING OFFICIAL 
 

NON-PROPRIETARY INFORMATION 
This procedure was prepared by the Safety Training Department and is scheduled for review in August 2018. 

119 

• To review documentation uploaded for the entire qual card, click All for This 
Qual Card. 

 

4. Complete the following items on the Review Competency form:  

• To approve the competency request:  

a. Select the appropriate evaluation method in the Evaluation Method list. 

b. Select Accept in the Review Result list. 

c. Document the decision in the Notes field. 

d. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
• To kick back the competency request:  

a. Select Kick Back in the Review Result list.  

b. Document the decision in the Notes field.  
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c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   

NOTE: The Kick Back result constitutes a determination by the QO that the 
Participant requires additional knowledge or action to meet the 
requirements of the competency. It can also be used when the QO is 
not available for the review.  

 

5. Click Submit to close the Review Competency form. 

• The Edit icon no longer appears next to the competency. 

• If the competency review request was accepted, the competency’s status is 
shown as Complete.  
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• If the competency review request was kicked back, the competency’s status is 
shown as Kicked Back, and the Participant has the option of submitting a new 
competency review request. 
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11.2 View the Review History of a Competency, Equivalency, or Completed Qual 
Card 

The history and status of all quals managed by the logged-in QO, and all associated 
competencies and equivalencies, can be reviewed from the Qual Card Admin tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the supervisor who directed the assignment 
of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• Review history is not available for competency or equivalency review requests that 
are currently in progress, but notes and supporting documentation can be 
reviewed. 

11.2.1 View the Review History of a Competency or Equivalency  

1. On the Qual Card Admin tab, click the Expand icon for the relevant qual card to 
display the qual card’s competencies.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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2. Click the View Details icon next to a competency that has been completed, is 
under review, or has been kicked back, to open the Review Competency or 
Review Equivalency form. 

 

3. Click the View Details icon next to a competency that has been completed, is 
under review, or has been kicked back, to open the Review Competency or 
Review Equivalency form. 

 

4. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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5. To close the Review Competency or Review Equivalency form and return to 
the list of quals and competencies, click Close.  

11.2.2 View the Review History of a Completed Qual Card 

1. Click the View Details icon next to the completed qual card to be reviewed to open 
the Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. In the Qual Card Review History list, click the Expand icon next to a review action 
to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• First and Second Line Supervisor names and Review Results 
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• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

3. To close the Review Qual Card form and return to the list of quals, click Close.  

11.2.3 Print the Status of All Competencies in an Active Qual Card 

1. Select the Qual Card Admin tab to display the qual cards administered by the 
logged-in QO. 

OR 

Select the Participants tab to display the participants administered by the 
logged-in QO. 

 2. Locate the appropriate qual card, and click the Print icon to the right of the qual 
title. 
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  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

3. A printable list of the competencies, including the reviewer name, history, and 
current status of each competency, opens in a separate tab. 
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3. Click Print to print the list of competencies,. 
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11.3 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards managed by the logged-in QO is 
displayed on the Qual Card Admin tab. The QO can export this list to an Excel 
spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported.  

1. If necessary, click a column heading to sort the list by qual title, the supervisor who 
directed the qual assignment, or the due date. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “RadGridExport.xls.” 
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• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 

5. If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

11.4 Sort the List of Qual Cards 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
• To sort the list of qual cards on the Qual Card Admin page by the values in one of 

the columns, click the appropriate column heading. 
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12.0 FTCP AGENT 

The FTCP Agent performs the final review and approval of Senior Technical Safety 
Manager (STSM) quals. 

All FTCP Agent actions take place on the Qual Card Admin tab. 

NOTE: When a 2nd Line Supervisor (or a 1st Line Supervisor if no 2nd Line Supervisor 
exists) submits an STSM qual for final approval, a notification email is sent to 
the FTCP Agent. 
 
The reviewing FTCP Agent can access eTQP by clicking the link in the 
notification email, as shown below. The link opens in the users default browser. 
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12.1 Review Final Qualifying Activities for an STSM Qual 

Documentation supporting a Participant’s final qualifying activities for an STSM qual 
(examination, facility walk-through, oral board, or oral interview) is uploaded by the 
eTQP Manager and submitted to the Supervisor or Supervisors and the FTCP Agent for 
final review and approval.  

1. On the Qual Card Admin tab, click the Edit Submission icon for the relevant qual 
to open the Review Qual Card form. 

 

2. Review the notes and documentation added by the Participant and Manager. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
3. Perform the appropriate evaluation. 

4. Complete the following items on the Review Qual Card form:  

• To approve the final qualifying activities:  

a. Select Accept in the FTCP Agent Review Result list. 

b. Check the box certifying that the candidate has successfully completed the 
qual. 

c. Document the decision in the Notes field. 

d. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 
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  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   
• To kick back the qual:  

a. Select Kick Back in the FTCP Agent Review Result list.  

b. Document the decision in the Notes field.  

c. Add supporting documentation. 

IMPORTANT: Do not upload classified, PII, or UCNI material to eTQP. 
Remember that exams may be classified, so check before 
uploading exams as supporting documents. 

  eTQP BASICS See Section 6.2 for help on working with 
documentation 

   

NOTE: The Kick Back result constitutes a denial of the request for approval. It can 
also allow the reviewer to request the submission of additional information 
by the Participant.  

 

5. Click Submit to close the Review Qual Card form.  
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• The Edit Submission icon no longer appears with the qual in the list of quals. 

• If the final qualifying activities were accepted and no additional Supervisor is 
required to approve the qual, the qual’s status is shown as Complete.  

• If the qual was kicked back, the qual’s status is shown as Kicked Back, and the 
Participant has the option of submitting it for review and approval again. 
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12.2 View the Review History of a Competency, Equivalency, or Completed Qual 
Card 

The history and status of all quals managed by the logged-in QO, and all associated 
competencies and equivalencies, can be reviewed from the Qual Card Admin tab.  

• Status information for each active or completed qual card includes the due date; 
the current percent complete; a status of Not Started, In Progress, Complete, or 
Complete (Legacy); and the name of the Supervisor who directed the assignment 
of the qual. 

 

• The review history includes any notes or documents added by the reviewer or 
Participant during the review process. 

• If the competency, equivalency, or qual has been kicked back one or more times, 
the review history includes the notes and documentation for each review request. 

• Review history is not available for competency or equivalency review requests that 
are currently in progress, but notes and supporting documentation can be 
reviewed. 

12.2.1 View the Review History of a Competency or Equivalency  

1. On the Qual Card Admin tab, click the Expand icon for the relevant qual card to 
display the qual card’s competencies.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 
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2. Click the View Details icon next to a competency that has been completed, is 
under review, or has been kicked back, to open the Review Competency or 
Review Equivalency form. 

 

3. In the Competency Review History list, click the Expand icon next to a review 
action to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 
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4. To close the Review Competency or Review Equivalency form and return to 
the list of quals and competencies, click Close.  

12.2.2 View the Review History of a Completed Qual Card 

1. Click the View Details icon next to the completed qual card to be reviewed to open 
the Review Qual Card form.  

  eTQP BASICS See Section 6.1 for help on locating items 
in a list. 

   

 

2. In the Qual Card Review History list, click the Expand icon next to a review action 
to review the following details:  

• Reviewer Name 

• Evaluation Method 

• Review Result  

• First and Second Line Supervisor names and Review Results 
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• Review Created Date 

• Review Result Date 

• Notes History 

• Supporting Documentation  

  eTQP BASICS See Section 6.2 for help on managing 
supporting documentation. 

   

 

3. To close the Review Qual Card form and return to the list of quals, click Close.  
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12.3 Export a List of Assigned Qual Cards to Excel 

A list of in-progress and completed qual cards managed by the logged-in QO is 
displayed on the Qual Card Admin tab. The QO can export this list to an Excel 
spreadsheet.  

NOTE: Only the qual card records are exported to the spreadsheet. If any qual cards 
are expanded to display the competencies, the competency records are not 
exported.  

1. If necessary, click a column heading to sort the list by qual title, the Supervisor who 
directed the qual assignment, or the due date. 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
2. Click the Export to Excel icon.  

 

3. In the confirmation dialog box, click Open or Save. 

 

4. eTQP creates a spreadsheet named “RadGridExport.xls.” 
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• Depending on the option selected in Step 4, the spreadsheet either opens or is 
saved to the user’s Downloads folder. 

5. If the Microsoft Excel dialog box is displayed, click Yes to open the spreadsheet. 

 

12.4 Sort the List of Qual Cards 

  eTQP BASICS See Section 6.1.2 for help on sorting items 
in a list. 

   
• To sort the list of qual cards on the Qual Card Admin page by the values in one of 

the columns, click the appropriate column heading. 
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